Lesson overview

In the previous lesson, you created a basic edit with Adobe Premiere Pro. In this lesson, you’ll use more advanced editing techniques and learn how to

- Apply various clip-trimming techniques in your Timeline
- Apply and modify an effect to clips in your Timeline
- Incorporate RED footage into your Timeline
- Create simple dissolve transitions between clips in your Timeline
- Create a static title with the Adobe Premiere Pro Title tool
- Edit closed captions
- Use the Warp Stabilizer effect to smooth unsteady camera movement in a clip
- Generate a preview render of your Timeline
- Upload a file and sync your settings to Creative Cloud

This lesson will take approximately 120 minutes to complete.

Download this lesson and its project files from the Lesson & Update Files tab on your Account page at www.peachpit.com and store them on your computer in a convenient location, as described in the Getting Started section of this book.

Your Account page is also where you’ll find any updates to the chapters or to the lesson files. Look on the Lesson & Update Files tab to access the most current content.
Applying the Warp Stabilizer effect to a clip in Adobe Premiere Pro
INDEX

Note that Chapters 4 and 6 are included in the files you downloaded with this book. In this index, the index numbers for Chapter 4 begin with a “4” and pages are numbered sequentially for that chapter. The numbers for Chapter 6 begin with a “6.”

NUMBERS

2K video compression standard, 53
3D Camera Tracker, 6:43–6:47
3D effects
  activating, 6:26–6:28
  applying extrusions, 6:29
  changing color of extrusions, 6:30–6:37
  Ray-traced 3D renderer, 6:25–6:26
4K video compression standard, 53
32-bit color, 313
64-bit support, in operating systems, 17

A

AAF (Advanced Authoring Format), 4:73
Action
  cutting on, 76
  elements of film script page, 28
Additive Dissolves, 4:42
Adjustment Layers
  in Adobe Premiere Pro, 323–325
  applying custom look in Adobe Premiere Pro, 329
  applying to SpeedGrade preset to, 325–326
  copying LumetriLooks effect, 330–333
  cutting, 330–333
  when to use, 322
Adobe After Effects. see After Effects
Adobe Anywhere service, 4:74
Adobe Audition
  adding sound effects, 282–284
  audio tools, 255
  cleaning up audio clips, 272–273
  creating final mix, 289
  multitrack editing, 286–288
  multitrack mixing and finishing, 280–282
  overview of, 5
  real-time track mixing, 279
  sending final mix back to Adobe Premiere Pro, 289–291
  spectral frequency display, 251, 274–276
Adobe Bridge
  adding metadata to media files, 26–27
  naming and managing media files, 22
  navigating and previewing media files, 22–25
  overview of, 4, 22
Adobe Creative Cloud. see Creative Cloud introduction
Adobe Flash Professional, 5, 355–358
Adobe ID, 30
Adobe Illustrator. see Illustrator
Adobe Media Encoder. see AME (Adobe Media Encoder)
Adobe Photoshop. see Photoshop
Adobe Prelude. see Prelude
Adobe Premiere Pro
  creating new project in, 54–55
  linking projects containing media files, 9, 11–14
  optimizing performance, 52–53
  overview of, 52
  roles of Creative Cloud components, 5
  sending project to, 46–47
  user interface, 56–58
Adobe Story
  collaborating on script with Adobe Story Plus, 34–35
  creating new A/V script, 29–33
  overview of, 4
  planning and managing production, 35–37
  simplifying formatting of media files, 27–28
Advanced Authoring Format (AAF), 4:73
After Effects
  3D activation, 6:26–6:28
  3D Camera Tracker, 6:43–6:47
  adjustment layers, 323–325
  advanced techniques, 248–249
  animating backgrounds, 212–213
  animating masks, 6:21–6:25
  animating opacity, 217–219
  animating text, 220–221
  animation presets, 226–230
  Aperture Color Finesse plug-in, 315
  applying extrusions, 6:29
  applying finishing touches, 6:37
  changing color of extrusions, 6:30–6:37
  Collapse Transformations, 216–217
  commonly used effects, 6:60
  Continuous Rasterization, 214–215
  converting vector layer to shape layer, 6:15–6:18
  creating a proxy for compositions, 6:69–6:73
  creating folders, 150
<table>
<thead>
<tr>
<th>Operation</th>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating new compositions</td>
<td>191–192, 6:7–6:9</td>
</tr>
<tr>
<td>Creating new projects</td>
<td>144</td>
</tr>
<tr>
<td>Creating text layers</td>
<td>193–195, 6:10–6:14</td>
</tr>
<tr>
<td>Displacement map effect</td>
<td>6:61–6:69</td>
</tr>
<tr>
<td>Drawing and using masks</td>
<td>6:19–6:20</td>
</tr>
<tr>
<td>Drop Shadow effects</td>
<td>195–196</td>
</tr>
<tr>
<td>Duplicating layers</td>
<td>197–201</td>
</tr>
<tr>
<td>Dynamic linking</td>
<td>6, 151, 235, 6:5–6:6</td>
</tr>
<tr>
<td>Easy-Ease interpolation of animations</td>
<td>221–223</td>
</tr>
<tr>
<td>Editing masks</td>
<td>6:20–6:21</td>
</tr>
<tr>
<td>Exporting video frames from Adobe Premiere Pro</td>
<td>6:76–6:77</td>
</tr>
<tr>
<td>Fractal noise effect</td>
<td>6:54–6:59</td>
</tr>
<tr>
<td>Global Performance Cache settings</td>
<td>16–17, 145–147</td>
</tr>
<tr>
<td>Graphic from Illustrator used in</td>
<td>190</td>
</tr>
<tr>
<td>Importing into Adobe Premiere Pro</td>
<td>152–153, 236–239</td>
</tr>
<tr>
<td>Incremental versions</td>
<td>6:4–6:5</td>
</tr>
<tr>
<td>Keyframing layer position in</td>
<td>139</td>
</tr>
<tr>
<td>Lower third graphics example</td>
<td>230–235</td>
</tr>
<tr>
<td>Motion blur effect</td>
<td>223–225</td>
</tr>
<tr>
<td>Motion graphics</td>
<td>157–160</td>
</tr>
<tr>
<td>Moving and scaling parented group</td>
<td>207–209</td>
</tr>
<tr>
<td>Nested compositions</td>
<td>209–211</td>
</tr>
<tr>
<td>Nesting and collapsing</td>
<td>6:40–6:43</td>
</tr>
<tr>
<td>Null Objects in</td>
<td>203–206</td>
</tr>
<tr>
<td>Optimizing performance of</td>
<td>144–145</td>
</tr>
<tr>
<td>Organizing compositions</td>
<td>6:74</td>
</tr>
<tr>
<td>Overview of</td>
<td>5, 138, 143</td>
</tr>
<tr>
<td>Parenting in</td>
<td>202–203</td>
</tr>
<tr>
<td>Pick-Whip as parenting option</td>
<td>206</td>
</tr>
<tr>
<td>Pre-composing</td>
<td>6:37–6:40</td>
</tr>
<tr>
<td>RAM Preview and</td>
<td>160, 6:7</td>
</tr>
<tr>
<td>Ray-traced 3D renderer</td>
<td>6:25–6:26</td>
</tr>
<tr>
<td>Re-interpreting frame rate of clip imported</td>
<td>153–157</td>
</tr>
<tr>
<td>Renaming compositions</td>
<td>6:7</td>
</tr>
<tr>
<td>Replacing existing clips in Adobe Premiere Pro</td>
<td>239–244</td>
</tr>
<tr>
<td>Replacing timelapse image with imported</td>
<td>6:74–6:76</td>
</tr>
<tr>
<td>Assets</td>
<td></td>
</tr>
<tr>
<td>Archiving projects</td>
<td>355</td>
</tr>
<tr>
<td>Aspect ratio</td>
<td>349</td>
</tr>
<tr>
<td>Audio</td>
<td></td>
</tr>
<tr>
<td>Adding sound effects</td>
<td>282–284</td>
</tr>
<tr>
<td>Adjusting loudness</td>
<td>270–271</td>
</tr>
<tr>
<td>Automating loudness</td>
<td>266–269</td>
</tr>
<tr>
<td>Creating final mix</td>
<td>289</td>
</tr>
<tr>
<td>Effects</td>
<td>262–264</td>
</tr>
<tr>
<td>Enhancements</td>
<td>111</td>
</tr>
<tr>
<td>Examining clips</td>
<td>270–271</td>
</tr>
<tr>
<td>Listening to footage</td>
<td>68–73</td>
</tr>
<tr>
<td>Listening to music and sound effects</td>
<td>79</td>
</tr>
<tr>
<td>Making audio gaps</td>
<td>130</td>
</tr>
<tr>
<td>Microphones</td>
<td>286</td>
</tr>
<tr>
<td>Monitoring</td>
<td>254–255</td>
</tr>
<tr>
<td>Multitrack editing</td>
<td>286–288</td>
</tr>
<tr>
<td>Multitrack mixing and finishing</td>
<td>280–282</td>
</tr>
<tr>
<td>Opening Audio Mixer</td>
<td>260</td>
</tr>
<tr>
<td>Overview of</td>
<td>250</td>
</tr>
<tr>
<td>Preparing tracks</td>
<td>261</td>
</tr>
<tr>
<td>Removing background noise</td>
<td>276–278</td>
</tr>
<tr>
<td>Removing transient sounds</td>
<td>275–276</td>
</tr>
<tr>
<td>Sending clips to Adobe Audition for cleanup</td>
<td>272–273</td>
</tr>
<tr>
<td>Sending final mix back to Adobe Premiere Pro</td>
<td>289–291</td>
</tr>
<tr>
<td>Spectral frequency display</td>
<td>274</td>
</tr>
</tbody>
</table>

**AME (Adobe Media Encoder)**
- Encoding video for web and mobile use: 350–354
- Export Settings panel in: 337
- Overview of: 5, 345
- Rendering master files: 345–348
- Saving presets: 349–350

**Analog bleed effect**: 6:121–6:125

**Analyze Content option, Project panel**: 84

**Animation**
- Of background in After Effects: 212–213
- Defined: 143
- Easy-Ease interpolation of: 221–223
- Keyframes in: 159
- Of layers in After Effects: 159–160
- Of masks in After Effects: 6:21–6:25
- Of opacity in After Effects: 217–219
- Playing MAXON animations: 6:103–6:104
- Presets: 226–230
- Of shape repeaters in MAXON CINEMA 4D/4D Lite: 6:119–6:120
- Of text in After Effects: 220–221

**Aperture Color Finesse plug-in**: 315

**Apple Final Cut Pro**: 4:73

**Archiving projects**: 355

**Assets**
- Asset management: 22, 25
- Importing as a bin: 64–65
- Navigating: 59
- Organizing: 24, 61–62

**Audio**
- Adding sound effects: 282–284
- Adjusting loudness: 270–271
- Automating loudness: 266–269
- Creating final mix: 289
- Effects: 262–264
- Enhancements: 111
- Examining clips: 270–271
- Listening to footage: 68–73
- Listening to music and sound effects: 79
- Making audio gaps: 130
- Microphones: 286
- Monitoring: 254–255
- Multitrack editing: 286–288
- Multitrack mixing and finishing: 280–282
- Opening Audio Mixer: 260
- Overview of: 250
- Preparing tracks: 261
- Removing background noise: 276–278
- Removing transient sounds: 275–276
- Sending clips to Adobe Audition for cleanup: 272–273
- Sending final mix back to Adobe Premiere Pro: 289–291
- Spectral frequency display: 274
tools, 255
tracks in Timeline, 96
verifying monitoring preferences, 258–259
voice-overs, 285
waveforms, 111, 259
working with media files, 6–7
workspace for, 256–257
Audio Clip Mixer, 111, 255, 270–271
Audio Gain, 265
Audio Meters, 58, 255, 257
Audio Mixer, 255, 260
Audio Plug-in Manager, 264
Audition. see Adobe Audition
A/V script
basic elements of, 28
starting new script in Adobe Story, 29–34
Avid, exchanging projects and, 4:73
Background noise, removing, 276–278
Backing up, 17
Batch processing, in Adobe Bridge, 22
Behance network
linking to social networks, 361–362
posting image to, 363–365
posting project to, 358
promoting project via, 361
Best Take comments, 26–27
Bins
creating, 41, 65–67, 4:55
in Creative Cloud interface, 6
importing assets as, 64–65
selecting clips in, 11–12
storing closed caption clip in, 4:66
Bitmap images, 7
Bitrate settings, 344
Boris Continuum Complete AE effects plug-in, 4:46
Boris FX effects plug-in, 312, 4:46
B-roll
adding jump cut to, 4:5–4:9
adding to sequences, 102–105
creating bin for, 65–67
defined, 33
Dynamic Timeline Trimming and, 4:16–4:20
Rate Stretch tool applied to, 4:9–4:16
viewing, 74–76
what it is, 73
Closed captions, 348, 4:56–4:66
Collaboration, in Adobe Story Plus, 34–35
Collaboration, in Adobe Premiere Pro, 310–312
Color Assist, from Technicolor, 312
Color correction
in Adobe Premiere Pro, 299
integrating into RED footage, 315–322
overview of, 298–299
pasting color correction effects between clips, 306–314
scopes, 302
setting up for, 300
Three-Way Color Corrector, 302–306
YC Waveform for, 301
Compatibility issues, video formats and, 7
CINEWARE plug-in. see MAXON CINEMA
4D/4D Lite
Clip editing
in Adobe Audition, 272
in Adobe Premiere Pro, 266
audio editing options, 265
Clips
adding last, 131–132
adding markers to, 91–94
adding RED clips, 4:24–4:28, 4:33–4:36
adding to sequence, 102–108
applying effects to, 4:43–4:44
applying speed/duration to RED clips, 4:28–4:30
creating subclips, 80–83
ingesting, 38–40
listening to, 68–73
logging clips, 26–27, 40
organizing, 61
pasting effects between, 306–314
previewing, 60, 160–161
reordering on Timeline, 108, 111
selecting, 11–12
sending to Adobe Audition for cleanup, 272–273
shortening music clips, 126–130
snapping for adding to sequence, 112–115
snapping for moving within sequences, 115–126
syncing, 128
trimming, 83, 4:5
viewing, 68, 74–78
working with media files, 6–8
Codecs, 8, 343
Capture tool, for tape media, 60
Central Processing Unit (CPU), 4:70
Capture tool, for tape media, 60
Central Processing Unit (CPU), 4:70
CINEWARE plug-in. see MAXON CINEMA
4D/4D Lite
Clip editing
in Adobe Audition, 272
in Adobe Premiere Pro, 266
audio editing options, 265
Clips
adding last, 131–132
adding markers to, 91–94
adding RED clips, 4:24–4:28, 4:33–4:36
adding to sequence, 102–108
applying effects to, 4:43–4:44
applying speed/duration to RED clips, 4:28–4:30
creating subclips, 80–83
ingesting, 38–40
listening to, 68–73
logging clips, 26–27, 40
organizing, 61
pasting effects between, 306–314
previewing, 60, 160–161
reordering on Timeline, 108, 111
selecting, 11–12
sending to Adobe Audition for cleanup, 272–273
shortening music clips, 126–130
snapping for adding to sequence, 112–115
snapping for moving within sequences, 115–126
syncing, 128
trimming, 83, 4:5
viewing, 68, 74–78
working with media files, 6–8
Closed captions, 348, 4:56–4:66
Collaboration, in Adobe Story Plus, 34–35
Collaboration, in Adobe Premiere Pro, 310–312
Color Assist, from Technicolor, 312
Color correction
in Adobe Premiere Pro, 299
integrating into RED footage, 315–322
overview of, 298–299
pasting color correction effects between clips, 306–314
scopes, 302
setting up for, 300
Three-Way Color Corrector, 302–306
YC Waveform for, 301
Compatibility issues, video formats and, 7
Compositing, 143
Compute Unified Device Architecture (CUDA), 15–16
Condenser microphones, 286
Continuous Rasterization, After Effects, 214–215
CPU (Central Processing Unit), 4:70
Creative Cloud introduction, 17–18
component roles, 4–5
dynamic linking, 6
linking projects containing media files, 9–14
overview of, 4
posting files to, 4:73–4:76
posting project to, 358–360, 4:72–4:73
real-time playback and editing, 15–17
syncing preferences, 4:76–4:77
user interface, 5–6
working with media files, 6–8
Cross Dissolve transitions, 4:38–4:42
CTI (current time indicator), Track Targeting and, 4:25
CUDA (Compute Unified Device Architecture), 15–16
Current time indicator (CTI), Track Targeting and, 4:25

D
Damage effects plug-in, 4:46
Delay effect, in audio, 262
Delirium effects plug-in, 4:46
Dialogue, 28
Digieffects effects plug-in, 4:46
Digital asset management software, 22
Digital single-lens reflex (DSLR), 4:20–4:23, 4:30–4:33
Disk cache, 16–17
Disk drives, 53–54, 144
Disk images, backing up, 17
Displacement map effect, 6:61–6:69
Dissolve transitions, 4:37–4:39
DNxHD, for Windows and Mac OSs, 345
Downloading, vs. streaming, 354
Drop Shadow effect, 195–196
Dropped Frame Indicator, 4:71
DSLR (digital single-lens reflex), 4:20–4:23, 4:30–4:33
DV Shade, EasyLooks, 312
Dynamic linking
between After Effects and Adobe Premiere Pro, 151, 235, 6:5–6:6
Dynamic Link feature, 6
update dynamically linked composition, 162–163, 245–246
Dynamic microphones, 286
Dynamic Timeline Trimming, 4:16–4:20
Dynamics effect, in audio, 262

E
Easy-Ease interpolation, 221–223
EasyLooks, DV Shade, 312
EBU N19 Subtitle File, closed caption standards, 348
Edit points, on Timeline
adjusting playhead position, 127
creating subclips and, 81–83
extending out point when creating dissolve, 4:39–4:42
selecting portion of clip to ingest, 38–39
snapping between, 112
snapping to, 115
Editing
adding closed caption, 4:56–4:66
adding markers for, 94–95, 133
adding reaction shots, 131
adding RED clips, 4:24–4:28, 4:33–4:36
advanced techniques, 136–137
applying effects, 4:43–4:46
applying speed/duration settings, 4:28–4:30
audio options, 111, 265, 286–288
completing rough edit, 134
creating bins for, 65–67, 4:55
Dynamic Timeline Trimming, 4:16–4:20
extract, 100–101
importing assets as a bin, 64–65
importing footage for, 59–60
incorporating RED footage, 4:20–4:22
insert edits, 109–110
interpreting footage, 62–63
jump cuts, 4:5–4:9
linear vs. nonlinear, 52
listening to footage and, 68–73
listening to music and sound effects and, 79
marking audio gaps, 130
moving frames forward/backward, 106–108
multicam, 133
muting and locking tracks, 97–98
optimizing performance, 52–54
overview of, 50–51, 4:1–4:2
overwrite edits, 108–109
posting project or files to Creative Cloud, 4:72–4:76
preparing for, 95–96
preserving rough edits, 4:2–4:3
Project panel and, 61–62
Rate Stretch tool, 4:9–4:16
real-time playback and, 15–16
RED vs. DSLR, 4:22–4:23
refining story, 126
relinking with Link & Locate feature, 84–88
rendering Timeline, 4:70–4:72
ripple delete, 99–100
ripple edits, 98
sequences, 88–91  
snaping between edit points, 112  
syncing and, 4:30–4:33, 4:76–4:77  
Timeline components and, 96  
titles, 4:47–4:54  
transitions, 4:37–4:42  
trimming clips, 4:5  
user interface features for, 56–58  
viewing footage, 67–68  
Warp Stabilizer effect, 4:67–4:70  
workspace for, 56–58  
Effects  
adding to clips, 4:43–4:46  
adding transitions, 4:37–4:42  
audio effects, 262–264, 282–284  
commonly used, 6:60  
Effects Controls panel, 310, 4:33  
Ellipse tool, 178–179  
Emotion, 76, 131  
Encoding video, for web and mobile use, 350–354  
Error messages, Adobe Premiere Pro, 10, 141, 4:3, 6:3  
Export Settings panel, in Adobe Media Encoder, 337  
Exporting, with Adobe Premiere Pro, 341–342  
Extract edits, 100–101  
Extrusions  
applying, 6:29  
changing color of, 6:30–6:37  
F  
Fast Color Corrector effect, 298  
Favorites tab, Adobe Bridge, 22  
Files  
managing RED clips, 4:31  
media files. see Media files  
posting to Creative Cloud, 4:73–4:76  
sharing via Adobe Story, 35–36  
size consideration in exporting, 344  
Final Cut Pro (Apple), 4:73  
Flash Professional, 5, 355–358  
Folders. see also Bins  
Adobe Bridge, 22  
creating in After Effects, 150  
understanding Creative Cloud interface, 6  
Fonts, serif vs. sans serif, 4:55  
Footage  
B-roll, 33  
copying and transcoding, 40  
interpreting, 62–63  
listening to, 68–73  
stabilizing, 4:67–4:70  
viewing, 59, 67–68  
Formats  
audio, 6–7  
compatibility and, 7  
factors to consider in exporting, 343  
video, 6  
Formatting menu, Adobe Story, 27–28  
Fps (frames per second), 62–63  
Fractal noise effect, After Effects, 6:54–6:59  
Frame rates  
DSLR vs. RED, 4:22  
factors to consider in exporting, 344  
re-interpreting frame rate of clip imported from After Effects, 153–157  
video clips, 62–63  
Frames, 62  
Frames per second (Fps), 62–63  
G  
Gain, Audio Gain, 265  
Gaussian Blur effect, 4:44–4:46  
Global Performance Cache, 16, 145–147  
GPUs (graphics processing units)  
CUDA (Compute Unified Device Architecture) and, 15–16  
error message for missing renderer, 10, 141, 4:3  
graphics cards, 16  
Mercury Playback Engine and, 4:70  
performance optimization and, 54  
Gradient fill, 170–175  
Graphics  
creating bin for, 4:55  
creating track for, 4:49–4:50  
importing from Illustrator into After Effects, 190  
storing closed caption clip in graphics bin, 4:66  
Graphics cards, 16, 144  
Graphics processing units. see GPUs (graphics processing units)  
H  
H.264  
artifacts and noise and, 4:20  
factors to consider in exporting, 343  
video codecs, 8, 53  
Hard drives, 53–54, 144  
Hardware requirements, for Adobe Premiere Pro, 52  
HD (high-definition), 53, 4:20  
HDR (high dynamic range) footage, 322  
Histograms, color correction and, 317–318  
Hover scrub, 60, 74
I
Icon View, 4–6
Illustrator
applying gradient fill, 170–175
creating background shapes, 168–169
creating groups of shapes, 177–178
creating images, 164–166
creating lower third backgrounds, 168
drawing circles, 178–179
duplicating layers, 185–189
duplicating shapes, 180–183
grouping shapes, 183–184
importing lower third background into After
Effects, 190
layers, 176
Mercury Performance System and, 17
overview of, 5, 164
user interface, 167
Image formats, 6:78
Images, posting to Behance network, 363–365
Importing, with Media Browser, 59–60
In points. see Edit points, on Timeline
Increments, 6:4–6:5
Insert edits, 109–110
International Standards Organization (ISO),
4:20–4:21
Interpret footage, xvi
ISO (International Standards Organization),
4:20–4:21

J
Jump cuts, 4:5–4:9

K
Keyframes, 159, 266–269
Keyword searches, in Adobe Bridge, 22

L
Layers, After Effects
animating, 159–160
converting vector layer to shape layer,
6:15–6:18
duplicating, 197–201
nested compositions, 209–211
shape layers, 6:17
snapping to frame edge, 6:12
solid layers, 6:56
text layers, 193–195, 6:10–6:14
working with, 157–158
Layers, Illustrator
duplicating, 185–189
organizing vector objects by, 176
Layers, understanding Creative Cloud interface, 6
Light leak, simulating, 6:48–6:50
Linear editing, vs. nonlinear, 52
Link & Locate feature, 84–88
Link Media, 12–13
Linking, to social networks, 361–362
List view, 59, 61
Listening
to footage, 68–73
to music and sound effects, 79
Locate File window, 13–14
Locking tracks, Timeline, 97–98, 128
Log Notes, Project panel, 62
Logging clips, 26–27, 40
Loudness Radar, 262–263
Lower third background
applying gradient fill to, 170–175
creating in Illustrator, 164–166
creating shape of, 168–169
finalizing, 230–235
importing from Illustrator into After Effects,
190
Lumetri Looks effects, 330–333
LumetriTM Deep Color Engine, 322

M
Mac OSs. see OSs (operating systems)
Magic Bullet Suite, 312, 4:46
Margins, 4:48
Markers
adding final, 133
adding to clips, 91–94
adding to frame, 118
adding to sequences, 94–95
snapping to, 115
Marquee-selecting, 66, 77–78, 129
Masks, After Effects
animating, 6:21–6:25
editing, 6:20–6:21
overview of, 6:19–6:20
MAXON CINEMA 4D/4D Lite
analog bleed effect, 6:121–6:125
animating shape repeaters, 6:119–6:120
applying materials, 6:105–6:107
applying shape repeaters, 6:114–6:119
creating materials, 6:107–6:112
importing .c4d file into After Effects,
6:96–6:99
importing MAXON clip into Adobe Premiere
Pro, 6:128–6:132
overview of, 6:1, 6:95–6:96
playing animations, 6:103–6:104
rendering proxy for MAXON clip,
6:126–6:128
replacing existing clips in After Effects with imported clips, 6:112–6:114
user interface, 6:100–6:102
MCC (MacCaption) VANC (Vertical ANcillary data space) File, 348
MCU (medium close up), 32
Media Browser, importing with, 59–60, 64–65
Media Composer, 4:73
Media files
adding metadata to, 26–27
adding notes to footage with Prelude, 40
adding time-based comments, 44–45
assembling rough cuts, 41–43
collaborating on script with Adobe Story Plus, 34–35
creating bins for, 41
dynamic example using Adobe Story for a new A/V script, 29–33
formatting with Adobe Story, 27–28
ingesting raw footage and metadata with Prelude, 37–39
linking project containing, 9–14
naming and managing, 22
navigating and previewing, 22–25
organizing by duration, 61
overview of, 20–21
planning and managing production with Adobe Story, 35–37
Prelude and, 37
sending project to Adobe Premiere Pro, 46–47
in video production, 6–8
Medium close up (MCU), 32
Memory cards, ingesting video clips from, 40
Mercury Graphics Engine, 17
Mercury Playback Engine, 15–16, 4:70
Metadata, 26–27, 37–39
Microphones, 286
Mixes
creating final, 289
multitrack, 280–282
sending final to Adobe Premiere Pro, 289–291
Mobile devices, 350–354
Modify Clip window, Adobe Premiere Pro, 63
Monitoring audio, 254–255, 258–259
Monitoring color information, 302
Motion blur effect, After Effects, 223–225
Motion graphics. see also After Effects
animating layers, 159–160
keyframes, 159
motion graphics artists vs. video editors, 143
overview of, 157
working with layers, 157–158
.mp4 files, 342
MPEG-4 video codec, 8
Multicam edits, 133
Music. see also Audio
listening to, 79
preparing tracks, 261
shortening clips, 126–130
Muting tracks, in Timeline, 97–98, 128, 260

N

Nested compositions, 209–211, 219
Nonlinear editing, 52
Notes, adding to footage, 40
Null Objects, in After Effects, 203–206

O

Opacity, animating in After Effects, 217–219
OpenCL (Open Computing Language), 16
OpenGL (Open Graphics Library), 144
Operating systems. see OSs (operating systems)
Optimizing performance, 52–54, 144–145
OSs (operating systems)
64-bit support, 17
Creative Cloud membership and, 4
DNxHD and, 345
performance optimization and, 53
Out points. see Edit points, on Timeline
Output for Web. see Web output
Overwrite edits, 108–109, 4:26

P

Parametric Equalization, audio effects, 262
Parenthetical element, of film script page, 28
Parenting, in After Effects
moving and scaling parented group, 207–209
Null Objects and, 203–206
overview of, 202–203
Pick-Whip as parenting option, 206
Performance, optimizing, 52–54, 144–145
Photoshop
making spine image label, 6:84–6:94
making VHS tape labels, 6:81–6:84
Mercury Graphics Engine and, 17
new features, 6:79
overview of, 5
user interface, 6:80–6:81
Pick-Whip parenting option, 206
Pixel Motion Blur effect, After Effects, 225
Playback
adjusting Playback Resolution, 77, 4:23
Playback Resolution menu in Program Monitor, 4:35
Rate Stretch tool, 4:10
real-time playback and editing, 15–16
Playhead
  adjusting playhead position, 126–127
  adjusting position of, 101
Playhead, in Timeline, 96
Posterize Time effect, 4:43–4:44
Posting images/projects, to Behance network, 358, 363–365
Post-production phase, of workflow, 3
Pre-composing, After Effects, 6:37–6:40
Prelude
  adding notes to footage, 40
  ingesting raw footage and metadata, 37–39
  overview of, 5, 37
Premiere Pro. see Adobe Premiere Pro
Pre-production phase, of workflow, 2
Preview panel, 25
Production, planning and managing, 35–37
Production phase, of workflow, 3
Program Monitor
  in Adobe Premiere Pro, 1
  enabling/disabling closed captions, 4:60
  Extract icon, 101
  panels of Editing workspace, 57
  safe margins in, 4:48
  Select Playback Resolution menu, 4:35
  viewing sequence frames in, 89
Project panel
  adding B-roll clips to sequence, 102
  Analyze Content option, 84
  creating new bin, 65–67
  of Editing workspace, 57
  naming sequences, 90
  opening B-Roll bin, 74
  organizing assets in, 61–62
Promoting projects, 361
ProRes, Apple, 345
Proxies
  creating for compositions, 6:69–6:73
  rendering for MAXON clip, 6:126–6:128
RAM Preview, 160–161, 163, 6:7
Raster images, 164, 214–215
Rate Stretch tool, 4:9–4:16
Raw footage
  adding notes to, 40
  ingesting with Prelude, 37–39
  RED camera and, 4:20–4:21
  SpeedGrade support for, 322
Ray-traced 3D renderer, 6:25–6:26
Razor tool
  creating jump cuts, 4:7–4:8
  cutting instrumental clip with, 128–129
  editing with, 103–105
  ripple deletes with, 99
Reaction shots, 131
Record button, Audio Mixer, 260
RED footage
  adding clips, 4:24–4:28, 4:33–4:36
  applying speed/duration to, 4:28–4:30
  color correction, 295, 315–322
  vs. DSLR, 4:22–4:23
  file management, 4:31
  incorporating, 4:20–4:22
  syncing with DSLR footage, 4:30–4:33
Red Giant effects plug-in, 312, 4:46
Redundant array of independent disks (RAID), 53–54
relink files, xv
Reverb effect, audio, 262
RGB Parade color scope, 302
Ripple edits/ripple deletes, 98–100, 129, 4:16–4:17
Roll Edit tool, 4:18, 4:39–4:42
Rough edits
  assembling rough cuts, 41–43
  completing, 134
  preserving, 140–142, 4:2–4:3, 6:2, 6:4
S
Safe Margins, in Program Monitor, 4:48
Sans serif fonts, 4:55
Scene heading element, of film script page, 28
Schedules, coordination with Adobe Story, 35–36
Scopes, for monitoring color information, 302
Scratch Disk error message, 10
Scripts
  Adobe Story and, 27
  basic elements of film script page, 28
  collaboration with Adobe Story Plus, 34–35
  creating new A/V script, 29–33
Scrubbing, 11
SD, 40
Selection techniques
  for clips in bins, 11–12
  marquee-selecting, 66, 129
for portion of clip using in/out point, 38–39
Selection tool, 103–105
snapping and, 115–116, 119–120, 124
Track Select tool, 119
Sequences
adding B-roll clips, 102–105
adding markers to, 94–95
creating first, 88–91
edited sequence in Timeline, 51
ingredient sequence from After Effects
to Adobe Premiere Pro, 152–153
modified name of, 4:2, 4:4
sending to Adobe Audition, 280–282
sending to SpeedGrade, 327
snapping for adding clips to, 112–115
snapping for moving clips within, 115–126
Serif fonts, 4:55
Shape repeaters, MAXON CINEMA 4D/4D Lite, 6:114–6:120
Shapes, converting vector layer to shape layer, 6:15–6:18
Shapes, in Illustrator
applying gradient fill to, 170–175
creating, 168–169
drawing a circle, 178–179
duplicating, 180–183
grouping, 183–184
making groups of, 177–178
Shots element, of film script page, 28
Slip tool, 106–108
Snapping
adding clips with, 112–115, 117–119, 121–126
between edit points, 112
layers to frame edge, 6:12
playhead to clip markers, 119–121
within sequences, 115–116
Social networks, 361–362
Solid layers, After Effects, 6:56
Solo button, Audio Mixer, 260
Sound bites, 68–73
Sound effects, 79, 280, 282–284. see also Audio
Source Monitor
adding clips to Timeline, 4:25
adding markers to clips, 92
adjusting playhead position, 126–127
creating subclips, 80–83
Insert button, 110
opening clips, 63
panels of Editing workspace, 56
playing/selecting clips, 70–73
Select Zoom Level menu, 4:32
trimming clips, 83
viewing clips, 68, 75–78
viewing music and sound effects, 79
Source Patching, 4:25–4:26
Spectral frequency display, 251, 274–276
Speech to Text workflow, Adobe Premiere Pro, 84
Speed/duration settings, RED clips, 4:28–4:30, 4:36
SpeedGrade
adjustment layers and, 323–326
for color grading, 322
creating custom look, 327–329
dynamic linking and, 6
overview of, 5
sending sequence to, 327
SSC (Scenarist Closed Caption) File, 348
Storage
capacity in Creative Cloud, 4
integrating with asset management, 25
Story, refining, 126
Streaming, vs. downloading, 354
Subclips, 80–83
Sync Lock, 4:25
Syncing
clips, 128
preferences in Creative Cloud, 4:76–4:77
RED with DSLR footage, 4:30–4:33
T
Tablets, encoding video for, 350–354
Tape, capturing from, 60
Technicolor Color Assist, 312
Text
animating in After Effects, 220–221
creating closed captions, 4:56–4:66
creating text layers in After Effects, 193–195, 6:10–6:14
Speech to Text workflow, 84
Three-Way Color Corrector, 302–306
Thumbnails
adjusting size of, 24
ingesting video clips with Prelude, 38
viewing content of Footage folder, 59
Timecode, 4:9–4:10
Timelapse images
previewing and making final changes to, 160–162
re-interpreting frame rate of imported clip, 153–157
replacing with imported After Effects
composition, 161–162
Timeline
adding B-roll clips to sequence, 106–108
adjusting playhead position, 127
in Adobe Premiere Pro, 1
components of, 96
creating graphics track, 4:49–4:50
customizing look of, 258
edited sequence in, 51
extract edits, 100–101
insert edits, 109–110
moving frames forward/backward, 106–108
muting and locking tracks, 97–98
overview of, 6
overwrite edits, 108–109
panels of Editing workspace, 58
preparing to edit in, 95–96
rendering, 4:70–4:72
reordering clips on, 108, 111
ripple deletes, 99–100
ripple edits, 98
snapping between edit points, 112
Title Safe/Action Safe guides, 207
Titles, adding, 4:47–4:54
Toggle Track Lock icon, 97, 129–130
Toolbars, in Creative Cloud interface, 5
Tools panel
  panels of Editing workspace, 58
  Rate Stretch tool, 4:10
  Razor tool, 99, 103–105
  Selection tool, 103–105
  Slip tool, 106–108
  Track Select tool, 119
Track Changes, collaboration and, 35
Track Meter, 258
Track Select tool, 119
Track Targeting, 4:25, 4:51
Tracks
  audio editing options, 265
  creating graphics track in Timeline, 4:49–4:50
  multitrack editing in Adobe Audition, 286–288
  multitrack mixing and finishing in Adobe Audition, 280–282
  preparing music tracks, 261
  in Timeline, 96
Transcoding footage, 40
Transfer Modes, 6:48, 6:51
Transient sounds, removing, 275–276
Transitions, 28, 4:37–4:42
Trapcode Shine effects plug-in, 4:46
Trim Mode, 4:16, 4:18
Trimming
  basic trim edits, 102–103
  clips, 4:5
  Dynamic Timeline Trimming, 4:16–4:20
  example of trimming Interview clips, 83
  Rate Stretch tool and, 4:9–4:16
TV pixels, simulating, 6:51–6:54
Twirling down/open, navigating Assets folder, 59

U
User interface (UI)
  Adobe Premiere Pro, 56–58
  After Effects, 147–149
  Creative Cloud, 5–6
  Illustrator, 167
  MAXON CINEMA 4D/4D Lite, 6:100–6:102
  Photoshop, 6:80–6:81

V
Vector images, 7, 164, 6:15–6:18
Vectorscope, 302
Video
  codecs, 8
  compatibility and, 7
  encoding for web and mobile use, 350–354
  ingesting, 38–40
  interpreting, 62–63
  tracks in Timeline, 96
  working with, 6
Video cards, 16
Video editors, 143
Videotape, capturing from, 60
Voice-overs, 285
Volume, adjusting/automating, 266–271

W
W3c/SMPTE/EBU Timed Text File, 348
Warp Stabilizer effect, 4:67–4:70
Waveforms, audio, 111, 259
Web output
  AME (Adobe Media Encoder) and, 345
  archiving projects and, 355
  aspect ratio and, 349
  closed caption standards and, 348
  encoding video for web and mobile use, 350–354
  Export Settings panel in Adobe Media Encoder, 337
  exporting to Web, 341–344
  interactivity with Flash Professional, 355–358
  linking to social networks, 361–362
  overview of, 336
  posting images to Behance network, 363–365
  promoting projects, 361
  rendering master files, 345–348
  saving settings as a preset, 349–350
  streaming vs. downloading, 354
  uploading projects to Creative Cloud, 358–360
White balancing, 298, 302–306
Windows OSs. see OSs (operating systems)
Wipe transitions, 4:42
Workspaces
  for audio, 256–257
  for color correction, 300
  in Creative Cloud interface, 5

Y
YC Waveform, 300–301
YCbCr Parade, 302

Z
Zoom, in/out, 4:7, 4:12
Production Notes

Digital Video with Adobe Creative Cloud was created electronically using Adobe InDesign CS6. Art was produced using Adobe Illustrator and Adobe Photoshop. The Myriad Pro and Warnock Pro OpenType families of typefaces were used throughout this book.

References to company names in the lessons are for demonstration purposes only and are not intended to refer to any actual organization or person.

Images

Photographic images and illustrations are intended for use with the tutorials.

Typefaces used

Adobe Myriad Pro and Adobe Warnock Pro are used throughout the lessons. For more information about OpenType and Adobe fonts, visit www.adobe.com/type/opentype/.

Team credits

The following individuals contributed to the development of this edition of Digital Video with Creative Cloud Classroom in a Book:

Writers: Adam Shaening-Pokrasso, Sam Young, and Adam Kennedy
Adobe Press Editor: Victor Gavenda
Senior Editor: Karyn Johnson
Developmental Editor: Corbin Collins
Copyeditor: Rebecca Rider
Production Editor: Maureen Forsys, Happenstance Type-O-Rama
Technical Editor: Simon Walker
Compositor: David Van Ness
Proofreader: Scout Festa
Media Producer: Eric Geoffroy
Indexer: Jack Lewis
Cover designer: Eddie Yuen
Interior designer: Mimi Heft

Authors

Adam Shaening-Pokrasso  Adam is a director/producer and owner of San Francisco based creative agency, 12FPS. He produces advertising and educational content for technology companies and motion graphics for award-winning documentaries. Adam also exhibits media works around the world and across the interweb.

Sam Young  Sam is a video editor and motion graphics artist based in San Francisco. He has produced music videos, corporate promotions, and documentaries. He enjoys coffee.

Adam E. Kennedy  Adam is a young filmmaker, photographer, and animator, who often blurs the lines between digital mediums in order to reveal meaningful relationships between art and science. He is known for his "Planet Universe" series in which he creates vibrant planetary imagery from images of old, rusty fire hydrants.

Contributors

Jeffery Paradise (music and talent)
Filip Nikolic (music and talent)
Saturn Jones (dancer)
Jocquese Whitfield (dancer)
Dwight Burks (producer)
Adam Shaening-Pokrasso (director)
Heidi Petty (creative director)
Tyler Winick (art director)
Matthew Rome (director of photography)
Kristina Willemse (assistant camera)
Chad Leto (grip and electric)
Ian Sotzing (grip and electric)
Winston Merchan (production assistant)
Adam Kennedy (production and editorial)
Richard Barley (sound recordist)

All video content produced by 12FPS (12fps.com) at Hampshire Street Studios in San Francisco, CA. Music produced by Poolside (poolsidemusic.com).
Lesson overview

In the previous lesson, you created a basic edit with Adobe Premiere Pro. In this lesson, you’ll use more advanced editing techniques and learn how to

- Apply various clip-trimming techniques in your Timeline
- Apply and modify an effect to clips in your Timeline
- Incorporate RED footage into your Timeline
- Create simple dissolve transitions between clips in your Timeline
- Create a static title with the Adobe Premiere Pro Title tool
- Edit closed captions
- Use the Warp Stabilizer effect to smooth unsteady camera movement in a clip
- Generate a preview render of your Timeline
- Upload a file and sync your settings to Creative Cloud

This lesson will take approximately 120 minutes to complete.
Applying the Warp Stabilizer effect to a clip in Adobe Premiere Pro
Beginning this lesson

If you are continuing from the previous lesson, feel free to continue with the Adobe Premiere Pro project you already have open. Skip ahead to “Preserving your rough edit in Adobe Premiere Pro.”

If you are starting here

If you are starting at this lesson, generate your own Adobe Premiere Pro project file from a copy of one provided for you.

1. Navigate to the Assets > Lessons > Lesson 04 folder on your hard drive.
2. Double-click to open the Adobe Premiere Pro project Lesson04_Start.prproj.
3. In Adobe Premiere Pro, choose File > Save As.
4. Navigate to the Lesson 04 folder on your hard drive. Name your Adobe Premiere Pro project file Poolside Edit 02. Click Save.

Note: Important! Currently, Adobe Premiere Pro CC does not retain interpret-footage settings on clips even though those clips don’t need relinking. Refer to the Getting Started section “Interpret frame rate of linked files” for steps on fixing this issue so you can follow this lesson.

Preserving your rough edit in Adobe Premiere Pro

Because you are continuing with a previous version of this edit, you’ll first save a new version of your sequence. This allows you to go back to the previous version if need be and is a recommended best practice in the video editing workflow.

1. In the Project panel, twirl open the Sequences bin.
2. Click the Poolside_BTS_01 sequence to select it. Choose Edit > Copy to copy it to your clipboard. Then choose Edit > Paste.

3. To modify the name of the sequence, click the name of the sequence to select it.
Potential error messages

When opening an Adobe Premiere Pro project file that was last saved on a different computer, you may encounter a couple of error messages. Don’t panic!

One such error message will tell you that the local scratch disk is not in the same place.

If this happens, choose File > Project Settings > Scratch Disks, then, for all settings in the Scratch Disks window, click the Browse button and navigate to a local folder on your hard drive where you want Adobe Premiere Pro to save your Captured Video and Audio, your Video and Audio Previews, and your Project Auto Saves.

Another error message you may encounter is one that tells you that there is a missing renderer.

This just means that the project file was last saved on a machine that was using a graphics processing unit (GPU) that is not present on the current machine. Again, don’t panic. Just click OK and carry on.
4 Change the name of the sequence to **Poolside_BTS_02**, press Return (Enter), and then drag it into the Sequences folder.

![Image of project manager with sequences](image)

5 Double-click the Poolside_BTS_02 sequence to load it in your Timeline.

Note that the sequence appears in a new tabbed Timeline in front of your original sequence.

![Image of Timeline with Poolside_BTS_02 sequence](image)

Having multiple Timelines open simultaneously can be useful in certain situations, but it can also be confusing. For the time being, you'll close the first Timeline to eliminate the possibility of accidentally modifying the wrong sequence.

6 In the Timeline, click the Poolside_BTS_01 tab to select it.

7 Press Command+W (Ctrl+W) to close this sequence.

The new sequence is now the only one visible in the Timeline, which will ensure that you are working on the most recent iteration.

8 Press Command+S (Ctrl+S) to save your Adobe Premiere Pro project.
Trimming clips in the Timeline

If you are starting at this lesson, you might want to take the opportunity to play through the whole edit to get a feel for its pacing.

There are a few edits left to perform in this sequence, and you will be applying some advanced techniques in the following exercise.

Adding a jump cut

A jump cut is an editing technique made famous by the French New Wave directors. A jump cut is an edit in which a middle portion of a shot is removed, resulting in an abrupt jump in filmic time. Often these are used in avant-garde films, TV commercials, music videos, or, in this case, documentaries about the making of music videos.

You will be applying a jump cut to one of the B-roll shots in your sequence. You will need to find that clip in your sequence. An easy way to do that is to search for that clip by name and then have Adobe Premiere Pro automatically find it for you in the sequence.

1 In the search field at the top left of the Project panel, type prod_adam_onset.

Adobe Premiere Pro will reveal prod_adam_onset.m4v in the B-Roll bin.

2 Double-click the B-Roll bin to open it in its own window.
3  Click the Icon View button at the bottom left if the bin.

At the bottom right of the icon for this clip, you will see a yellow filmstrip icon, indicating that this clip is used in a sequence.

4  Click this filmstrip icon, and you will see a tip, showing you in what sequence(s) this clip is being used, and at what sequence timecode.

5  Click the tip for Poolside_BTS_02.
   The Timeline playhead will automatically jump to this clip’s In point in Poolside_BTS_02.

6  Select the B-Roll bin to make it active, then press Command+W (Ctrl+W) to close it.
7  Click the X icon in the Project panel search field to clear the field.
8  Click the Timeline tab for Poolside_BTS_02 to make the Timeline active.
9  Press the equal key (=) a few times to zoom in on your Timeline.

Press the spacebar to play the sequence from here.

Notice that this shot is good, but it could be shortened so that we can see Adam's face when he says “it's gonna be awesome.” However, we don't want to move any other clips after this one farther ahead in time.

You will trim this clip by using the Razor tool to cut out a middle section, delete the middle section, and then move the first of the two resulting parts ahead so it is adjacent to the second part. This will result in a jump cut.

1  Choose the Razor tool from the Tools panel.

2  Scrub the Timeline playhead to 00:01:39:23.
3 Apply the Razor tool to the clip here.

4 Adjust the Timeline playhead to 00:01:42:02.
5 Apply the Razor tool to the clip here.

6 Press the V key to activate the Selection tool.
7 Select the middle section of the clip.
8 Press the Delete key to remove it from the Timeline.

9 Select the first bit of the clip.
10 Move it forward on track Video 2 so its Out point snaps to the In point of the other copy.
11 Adjust your playhead back a few seconds. Press the spacebar to play the edit.
A jump cut within a shot is one way to trim it. Another way is by trimming its duration but not its content. In other words, by speeding it up.

**Using Rate Stretch**

In this exercise, you are going to apply the Rate Stretch tool to a couple of B-roll clips so that their middle portions play at faster-than-normal speed.

1. Scrub the Timeline playhead to the In point of prod_matt_jeff.m4v, the next clip in the sequence on Video 2.

2. Press the spacebar to play this clip.

   Note that it’s well composed throughout, but it’s too long. You want to make it shorter overall but still see everything in the clip’s duration. But you don’t want to make the entire clip play faster. Instead, it would look cool if the clip started at normal speed, suddenly played fast, then slowed down to normal speed again.

3. Choose the Razor tool from the Tools panel.

4. Adjust the Timeline playhead to timecode 00:01:43:02.
5. Apply the Razor tool to the clip at this frame.

6. Adjust the playhead to timecode 00:01:45:19.

7. Apply the Razor tool to the clip here.

8. Now choose the Rate Stretch tool from the Tools panel.

The Rate Stretch Tool allows you to adjust the playback speed of a clip by stretching its In or Out points in the Timeline. By stretching, or lengthening, the clip, it will play slower. Shortening a clip with the tool will make the clip play faster.
9 Hold down Shift as you scrub the playhead, snapping it to the tail of the first portion of prod_matt_jeff.m4v in the Timeline.

10 Adjust your playhead ahead (to the right) by 12 frames.

**Tip:** The left and right arrow keys move the playhead one frame backward and forward, respectively. Shift+left/right arrow key moves the playhead backward or forward five frames.

With the Rate Stretch tool, grab the tail of the middle portion of the prod_matt_jeff.m4v clip until it snaps to the playhead.

11 Choose the Selection tool from the Tools panel, or activate it by pressing the V key.

12 Marquee-select the two prod_adam_onSet.m4v clips and the first two portions of prod_matt_jeff.m4v.

13 Move these forward (to the right) in the Timeline so that the tail of the second portion of prod_matt_jeff.m4v snaps to the third portion of this clip.

14 Scrub your playhead back a couple of seconds before prod_adam_onSet.m4v, and press the spacebar to play through these edits.

**Note:** The In point of a clip in a sequence is sometimes called the head, and the Out point of a clip in a sequence is sometimes called the tail.
Let’s do this with another clip, prod_shooting_jeff_filip.m4v, which is a half dozen clips ahead on Video 2.

Note that this clip is a good duration in the sequence, but for a more dramatic effect, there should be more frames of the fog machine blasting fog.

1. Double-click prod_shooting_jeff_filip.m4v to open it in the Source Monitor.
2. Press the minus key (–) to zoom out in time, until the raw clip’s full duration is visible in the Source Monitor Timeline. Scrub the playhead through the clip’s frames. Notice that there is a lot of media to use beyond what is currently within the clip’s In and Out points.
If you tried extending the clip’s Out point in the Source Monitor, it would not work because there is a clip immediately after it in the sequence.

What you will need to do is temporarily move this clip into track Video 3, extend its Out point, make a couple of cuts in the clip, apply the Rate Stretch tool to the middle portion, close the gap, and then move all three bits of the original clip back to Video 2.

3 Activate the Selection tool by pressing the V key.

4 Select prod_shooting_jeff_filip.m4v and drag it up to Video 3.

5 Use the Selection tool to extend the clip’s Out point as far to the right as it can go.
Now you will mark the frames that will comprise the end of the clip to be shown.

1. Back in the Source Monitor, scrub the playhead to 00:00:12:17.
2. Press the M key to apply a Layer Marker to mark the first of the last several frames that will be shown.
3. Move the playhead ahead to 00:00:13:06.
4. Press the O key to Mark Out.

Now let’s do some edits in the Timeline.

1. Choose the Razor tool from the Tools panel.
2. Snap the Razor to the clip at the Layer Marker and make a cut.
3. Activate the Selection tool by pressing the V key.
4. Move the second bit of prod_shooting_jeff_filip.m4v back to Video 2, so its Out point snaps to the In point of prod_tyler_dwight_reaction.m4v.
5. Choose the Rate Stretch tool from the Tools panel.
6. With it, extend the In point of this second portion of the prod_shooting_jeff_filip.m4v clip backward 12 frames.
By doing this, you are making the last 12 frames of the original clip play in slow motion.

The clip starts with the camera zooming out. Let the portion play back in real time.

1. Adjust the Timeline playhead to 00:01:53:00.
2. Activate the Razor tool by pressing the C key.
3. Cut the long portion of prod_shooting_jeff_filip.m4v at the current time.

Now you will make the middle portion of prod_shooting_jeff_filip.m4v play back sped-up.

1. Use the Rate Stretch tool to adjust the Out point of the clip in Video 3 to snap to the In point of its copy in Video 2.
2. Activate the Selection tool by pressing the V key. Marquee-select the first two portions of prod_shooting_jeff_filip.m4v in Video 3, then drag them back down into Video 2.
3. Adjust the playhead back a few seconds and then press the spacebar to play through the edit.
4. Press Command+S (Ctrl+S) to save your project.